
Accordance 
Quick Reference Guide

The Accordance interface is designed around a few key concepts:

1. The Bible is Central

The text of the Bible, rather than a list of books or web-style browser, is the central 
interface element of Accordance

2. Searching is Central

Everything you need to do a search is available in the top part of the window.

3. What You See is What You Get

What you enter in the top part of the window is always reflected in the bottom part.

The only exception is when you change the search criteria but do not click the 
Search button to perform the search. At those times, the Search button becomes 
active to indicate that you need to update the search.

4. Instant Access

The Resource palette gives you instant access to every Bible, commentary, and study 
aid you own.

If you select some text before choosing a resource from the Resource palette, that 
resource will automatically be searched for the text you selected.

5. Economy of Effort

Triple-clicking a word or Scripture reference will automatically look it up in the first tool of 
the appropriate type. (See page 3)

The Instant Details box at the bottom of the screen gives you instant information about 
certain items your mouse passes over.

6. Minimal Clutter

Window panes and workspace tabs reduce the number of windows you have to manage 
and rearrange.

7. Consistency

Once you learn how to do something in Accordance, you’ll utilize numerous other 
features in much the same way.
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Using the Resource Palette
The Resource palette gives you instant access to all your Accordance resources.

Organization

Texts are primary resources: Bible texts and translations, as well as ancient writings 
like Josephus, Qumran, Mishna, etc. Texts are divided by language: English, Greek, 
and Hebrew. Text Sets let you group multiple texts together for one-step opening or 
searching.

Also in the Texts section are the Parallels and Context buttons. Parallels let you view 
parallel passages in the Gospels, Old Testament, etc. Context opens a window 
showing you the selected verse in context.

Tools are secondary resources which give you more information about the Texts, such 
as commentary on the Bible or index of Qumran scrolls. Tools are divided into five 
categories according to their structure:

Type of Tool Structure Look Here For

English Tool English Alphabetical Order Bible Dictionaries, Topical 
Resources, etc.

Greek Tool Greek Alphabetical Order Greek Lexicons

Hebrew Tool Hebrew Alphabetical Order Hebrew Lexicons

Reference Tool Bible Verse Order Commentaries, Cross-References, 
Translation and Study Bible Notes, 
Outlines

General Tool Any Other Method (Chapter and 
Section, Calendar Date, etc.)

Historical Works, Systematic 
Theologies, Devotional Literature, 
Grammars, etc.

Tool Sets let you group multiple tools (of any type) together for one-step opening or searching.

The Background section of the palette includes the Map and Timeline.

The My Stuff section of the palette includes User Tools and User Notes.

The Language section of the palette gives you instant access to various language tools.

Finally, the Search button lets you search the current resource or groups of resources. The 
Favorites button gives you one convenient place to find any resource you put there.
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Opening and Amplifying
The Resource palette can be used in two ways: to open resources or to amplify to them.

If you do not have any text selected in a text pane, selecting a resource from the Resource 
palette will simply open it. This is analogous to taking a book off the shelf and opening to the 
first page.

If you select a word or verse reference in a text pane, and then choose a resource from 
the palette, your cursor will change to a magnifying glass to indicate that the resource 
you choose will automatically be searched for the selected word. We call this automatic 
search feature amplifying.

Note: You can override the amplify feature by holding down the control key (or right-clicking) 
while selecting a resource from the palette. This will simply open the resource without 
searching, even if you have text selected.

Triple-Clicking
Triple-clicking is a shortcut to amplifying. When you triple-click a word or verse reference, 
Accordance will automatically look it up in the appropriate resource. The resource opened will 
depend on the kind of text you triple-click.

Note: The resource opened will be that tool which is at the top of your list of tools for that type. 
For example, if Anchor Bible Dictionary is at the top of your list of English tools, that will be the 
dictionary that opens when you triple-click an English word.

Tip: To change the tool which appears at the top of each category, choose Arrange Modules… 
from the Edit menu. 

Contextual Menus
Contextual menus also provide an easy shortcut to amplifying. Control- or right-click a word to 
Search for that word (or its associated Key Number, Lexical form, etc.) in the current text, to 
Search in any Bible text, or to Look Up in a default dictionary, commentary, or other resource.
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Triple-click a … To look it up in a …

Greek word Greek Tool

Hebrew word Hebrew Tool

English word in a Bible with 
Strong’s numbers

Greek or Hebrew Strong’s 
Dictionary

English word in a text without 
Strong’s numbers

English Tool

Verse Reference Reference Tool



Working with Workspaces
The Tabbed Workspace window is a container window which keeps most other Accordance 
windows neatly organized as workspace “tabs.”

Getting Started with Workspaces

To turn on Workspaces, choose Preferences… from the Accordance menu, make sure General  
settings are selected, and check the following checkbox:

You can also choose New Workspace from the File menu to open a new blank workspace.

Maintaining the Status Quo

Whether Accordance opens a new resource as a tab within a Workspace window or as a 
separate window all depends on what window you have active (frontmost). If a Workspace 
window is active and you open a resource, it will open as a tab within that workspace. If a 
separate (non-workspace) window is active, any new resources you open will open as separate 
windows. You can mix and match workspaces and separate windows however you like.

Tip: If you’re in a workspace and you want the next resource you open to open as a separate 
window, hold down the command key while selecting that resource from the Resource palette.

Detaching, Merging, and Moving Tabs

If you want to take a workspace tab and detach it so that it becomes a separate window, select 
Detach Tab from the window menu (command-option-T).

If you want to merge a separate window into an existing workspace, select Merge Windows 
from the window menu (command-option-M).

Note: Merge Windows will always merge the top two windows together into a workspace. If 
you have two separate windows, and no workspaces open, choosing this command will create a 
new workspace with tabs for those two windows. If you merge two workspaces, you’ll end up 
with a single workspace containing all the tabs from the original two workspaces.

Within a workspace, you can rearrange the tabs by dragging them to the left or right.

If you want to move a tab from one workspace into another workspace, simply drag its tab into 
the tab area of the second workspace. Holding the option key while moving a tab creates a new 
copy of it.
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Working with the Search Window
The Search window is the main Bible window in Accordance. It is divided into two parts by a 
moveable divider bar. 

The search entry box above the bar gives you everything you need to define a search:

The text pane below the bar lets you view and navigate your search results:

What You See is What You Get

It is important to understand that the verses displayed in the text pane always depend on what 
you have entered in the search entry box. 

When the Verses button is selected, only those verses you enter will be displayed. If you enter 
Psalms, only the book of Psalms will be displayed. If you try to scroll down to Proverbs, you’ll 
find that the text stops at Psalm 150.

Tip: When you simply want to go to a particular passage, leave the search entry box set to the 
asterisk (*), which indicates that the entire Bible should be displayed in the text pane. Then use 
the Go To box to navigate to the verses you want to see.

When the Words button is selected, only those verses containing the search term will be 
displayed. The Go To box is then useful for navigating within the hit verses.
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Number of words and verses found Click for more info about search Add panes 
showing parallel  
Bibles, reference 
tools, and notes.

Quickly resize 
text in this pane. 
Option to click to 
resize text in all 
panes.

Click to close 
this pane

Choose Bible 
text to display in 
this pane

Unless you add 
context in the 
search entry 
box, only verses 
containing a “hit” 
are displayed.

Click to move up or down one 
verse, chapter, or book

The Go To box shows the verse at the top of the pane. 
Enter a different verse and click the button to go there.

Choose Bible 
text to search

Choose to search by words or by verses

Enter search 
argument

Specify search field
(see next page)

Specify range of books, 
chapters, and verses to search

Go back to 
previous searches

Click to perform 
search

Click to compare 
two texts

Specify degree 
of context to add



Entering Verse References
When entering verse references, you only need to enter enough of a book name to uniquely 
identify it. For example, 1j is enough to identify 1 John, but Joh is the minimum necessary to 
distinguish John from Jonah. Certain standard abbreviations are also recognized, so you can 
also enter Jn for John.

The number immediately after a book name always indicates the chapter number (except in the 
case of books with only one chapter). Use a colon or period between chapter and verse 
numbers. Gen 1:2 and Gen 1.2 both indicate Genesis chapter 1 verse 2.

Ranges and Series

To enter a range of books, chapters, or verses, use a hyphen. Gen-Deut will display every book 
from Genesis to Deuteronomy. Gen 5-7 will display Genesis chapters 5 through 7. Gen 1:26-27 
will display Genesis chapter 1, verses 26 through 27.

To enter a series of references, use a semicolon to separate unlike items, and a comma to 
separate like items. Gen 2:5-6, 9-10; 3-4 will display verses 5 through 6 and 9 through 10 of 
Genesis chapter 2, along with chapters 3 through 4. The comma in this series indicates that 
9-10 refers to verses in the previously listed chapter, while the semicolon indicates a move back 
up to the chapter level.

Adding f or ff after a reference will add one or more verses, chapters, or books following the 
reference. Thus, Mal 2:4f includes verses 4 and 5, while Mal 2:4ff includes all the verses to the 
end of chapter 2. Mal 2ff includes all the chapters until the end of the book, and Mal ff includes 
all the books to the end of the Bible.

Searching for Words and Phrases
To search for a word, click the Words button, type the word in the entry box, and click the 
Search button.

To search for a phrase, simply type the phrase and click OK (e.g.: In the beginning). There is no 
need to enclose the phrase in quotation marks.

Note: The search syntax in Accordance is different from that of web search engines such as 
Google or desktop search engines like Spotlight. Those search engines take any series of 
words as an OR search, and then rank the results. To search for an exact phrase, these search 
engines require you to enclose the phrase in quotes. While this is an excellent interface for 
broad searches of many pages/documents, it is a poor interface for searching text of the Bible.

To expand your search beyond simple words and phrases, use the Search commands and 
symbols listed in the Search menu (see the pages that follow).
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Using Search Commands and Symbols
You can find a list of all the commands in the Enter Command submenu of the Search menu.

Connecting commands define relationships between two or more expressions. You can set 
the literary unit (or field) within which the elements must appear in the Search within every 
pop-up menu in the More options section of the Search window.

<AND> Finds X and Y when both appear in the same field

<OR> Finds X or Y when one, the other, or both appear in the same field.

<NOT> Finds X only when it does not appear in the same field as Y.

<XOR> Finds X or Y when one or the other, but not both appear in the field.

<FOLLOWED BY> Finds X when followed by Y in the field.

<PRECEDED BY> Finds X when preceded by Y in the field.

<WITHIN ? Words> Finds X and Y when they appear within so many words of each other in the 
field. Replace the question mark (?) with a number to specify the number of 
words within which the second expression must appear.

Stand-alone commands define some kind of search expression rather than connecting other 
expressions. Use connecting commands to join stand-alone commands with other expressions. 

[LINK ?] Uses the search argument from another window or workspace tab. This lets 
you perform the same search simultaneously in different texts or with different 
search settings.

[CONTENTS ?] Uses the list of verses from another window. Lets you constrain a search to 
the verses contained in another Search window or Reference List window.

[HITS ?] Uses the list of hit words from another window as a search argument. This 
powerful command lets you compare the vocabulary of different passages, 
translations, or texts.

[INFER ?] Powerful command which lets you search one text or passage for phrases 
which appear in another text or passage. See Accordance Help.

[FUZZY ?] Lets you search for inexact phrases. Placed before a phrase, the number 
indicates how many words can be dropped from the phrase to find a match.

[MERGE ?] Used for sophisticated searches in Reference Tools. See Accordance Help.

[RANGE ?] Lets you create a temporary range. For example, love <AND> [RANGE 1j-3j] 
would find all occurrences of the word “love” in 1 John through 3 John.

[COUNT ?] Finds words which only appear a certain number of times. [COUNT 1] finds 
all words occurring just one time.

[KEY ?] Finds all words in a Key numbered text which have been tagged with a 
certain Key number.
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[STYLE ?] Finds all occurrences of a given highlight Style.

[FIELD ?] Use with the <WITHIN> command to specify how close a word should be to 
the beginning or end of the Search field. For example, David <WITHIN 1 
Words> [FIELD Begin], would find every place where “David” is the first 
word in the field.

Search Symbols

Symbols (such as * and ?) are used to help define search arguments. The Enter Symbol 
submenu (Search menu) shows the available symbols with a brief description of their function.

* (wildcard) Stands for multiple characters of any kind. lov* will find “love,” “lover,” 
“loves,” “lovingkindness,” etc.

? (character 
wildcard)

Stands for one character of any kind. love? will find “loves,” “lover,” and 
“loved,” but not “lovers” or “lovingkindess.”

You can specify which characters the character wildcard can be by placing 
them in parentheses immediately after the question mark. b?(ae)t will find 
“bat,” and “bet,” but not “bit” or “but.”

- (not) Use after a wildcard to specify things that should not be included:

lov*-loving* will find all forms of the word “love” except “loving” and 
“lovingkindness.”

Use within parentheses after a character wildcard to specify characters which 
that wildcard cannot be. b?(-ae)t will find all three-letter words beginning with 
“b” and ending with “t” except “bat,” and “bet.”

= (equals) Use within parentheses after a character wildcard to find duplicate characters.

????(=3)?(=2)?(=1) finds all six-letter palindromes, such as “Hannah”

@ Used to join multiple search criteria which must apply to the same word. 

love@[KEY G26] will find “love” only when it has been tagged with Key 
number G26.

agapaw@[VERB aorist] will find agapaw only when it appears in the 
aorist tense.

[VERB] @ [COUNT 1] will find all verbs which only appear one time.

. (period) Lets you search for specific characters such as punctuation marks, Greek 
accents, Hebrew vowel points, etc. For example, .? will find every question 
mark. said ., .“ will find the word “said” followed by a comma and an opening 
double quote.

+ (plus) Use in tagged Greek and Hebrew texts to search for all words derived from a 
root form. For example, +agaph finds agaph, agapaw, and 
agaphtoß.

8.



Searching Greek and Hebrew Texts
When you search grammatically tagged Greek and Hebrew texts, it is important to understand 
that Accordance defaults to finding the broadest possible results. You can narrow your search 
using certain specialized symbols.

If you enter… Accordance will find…

A Greek or Hebrew 
word with no other 
symbols

All occurrences of that lexical form and will ignore vowel points and 
accents.

Entering a°ra will find the lexical forms a°ra, a‡ra, and aÓra¿.

Entering bOrDo will find every lexical form with the consonants ayin, resh, 
beth, regardless of how it is pointed.

A Greek or Hebrew 
word preceded by an 
equals sign (=)

All occurrences of that exact lexical form. In other words, accents and vowel 
points are taken into account.

Entering =a°ra will find only the lexical forms a°ra.

Entering bOrDo= will find only the lexical form bOrDo.

A Greek or Hebrew 
word enclosed in 
quotation marks (")

All occurrences of that inflected form and will ignore vowel points and 
accents.

Entering "a°ra" will find all inflected forms with the letters ara, regardless 
of its breathing mark and accents.

Entering "bOrDo" will find every inflected form with the consonants ayin, resh, 
beth, regardless of how it is pointed.

A Greek or Hebrew 
word enclosed in 
quotation marks (") 
and preceded by an 
equals sign (=)

All occurrences of that exact inflected form. In other words, accents and 
vowel points are taken into account.

Entering "=a°ra" will find all inflected forms with those exact letters and  
accents.

Entering "bOrDo=" will find every inflected form with those exact consonants 
and vowel points.

Note: When searching Hebrew, it is also important to take morphological separation into 
account. Because Hebrew has words which are prefixed and suffixed to other words, 
Accordance treats those words separately, even though in the text they may look like a single 
word. For example ty™IvaérV;b is really a phrase made up of two words: V;b and ty™Ivaér. When you 
search for this phrase, be sure to enter a space between them in the entry box.

Tip: If you select a Hebrew phrase in the text, then click the Search button on the Resource 
palette, Accordance will automatically break it up into separate words and search for it.
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Miscellaneous Tips
Use the Details button to get summary information about the results of a 
search. This is one of the most powerful and under-used features of 
Accordance.

The one keyboard shortcut you absolutely must learn is Command-T. Use it to change the 
appearance of text or graphics in the frontmost Accordance window or tab.

When you do a search in a Tools window, it is sometimes hard to know which article you’re in. 
You can look at the Go To box for the name of the top level article and the immediate current 
subarticle. You can also open the Browser and option-click the arrow to open the top level of 
the hierarchy. This will expand the browser to show you every article and subarticle which 
contains the current article.

If you option-click a title in the Tools Browser, that article will be highlighted in red, and your next 
search will be limited to just that section of the tool.

If you select a word in a Bible with Key numbers, then hold down the option key while selecting 
a resource from the Resource palette, that resource will be searched for the Greek or Hebrew 
word which that word’s Key number represents.

Where to Look for Help
Accordance Help is a thorough, up-to-date reference in the Help menu of Accordance.

The Accordance Tutorial will walk you through most of the features of the program. It is one of 
the first items in the Accordance Help.

The Accordance Blog gives you an inside look into the latest Accordance developments and 
newest releases. It’s also a place where you’ll find frequent tips. You’ll find it online at http://
www.accordancebible.com/blog/

The Accordance Forums are a great place to go for answers to your questions. You’ll find it 
online at http://www.accordancebible.com/forums/

You’ll find a great deal of documentation in the Manuals & Documents folder inside your 
Accordance folder.

You can view several free Flash video demos at http://www.accordancebible.com/resources/
downloads/demos.php

The Accordance Training Seminar DVD has video tutorials of many of the program’s features. 
These tutorials are also freely available online: http://www.accordancefiles2.com/training/
Start.html

You can subscribe to our new Lighting the Lamp podcast through iTunes.
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